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EXCEL

Editing and Formatting Worksheets

Section 2

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Skills

• Edit the content of cells

• Clear cells and cell formats

• Use proofing tools

• Insert and delete columns and rows

• Move and copy cells

• Use Paste Options to link cells

• Create formulas using absolute references

• Adjust column width and row height

• Change the font, size, style, and color of cells

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Skills

• Apply numeric formats and adjust the number of 

decimal places

• Use Undo, Redo, and Repeat

• Change cell alignment and indentation

• Add borders and shading

• Copy formats using Format Painter

• Apply cell styles

• Find and replace cell entries and formats

• Freeze and unfreeze panes

• Change the zoom percentage

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Editing and Clearing Cells;

Using Proofing Tools

• Open WBQuote-MarqueeProd.xlsx. 

• Save workbook with Save As in ExcelS2 folder and 

name it ExcelS2-01.xlsx.

ACTIVITY

2.1

ExcelS2-01.xlsx

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Editing and Clearing Cells;

Using Proofing Tools

• Double-click I21.

• Press Right or Left Arrow key to move insertion 

point between decimal point and 4, then press 

Delete.

• Type 3 then press Enter.

ACTIVITY

2.1

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Editing and Clearing Cells;

Using Proofing Tools

• Make I27 active.

• Move pointer after 1 in Formula bar then click left 

mouse button.

• Press Backspace to delete 1, type 4, then click 

Enter on Formula bar.

ACTIVITY

2.1



2

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Editing and Clearing Cells;

Using Proofing Tools

• Make A9 active then press Delete.

• Select range I17:I18. With Home tab active, click 

Clear then click Clear All.

ACTIVITY

2.1

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Editing and Clearing Cells;

Using Proofing Tools

• Press Ctrl + Home to move active cell to A1.

• Click Review tab

then click

Spelling.

• Click Ignore All in Spelling box to skip all 

occurrences of Rivermist.

ACTIVITY

2.1

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Editing and Clearing Cells;

Using Proofing Tools

• Click Change in Spelling

box to replace Torontow

with Toronto.

• Click Change in Spelling

box to replace Persns

with Persons.

• Complete spell check,

change words as

required. Click OK

when spelling check

is complete.

ACTIVITY

2.1

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Editing and Clearing Cells;

Using Proofing Tools

• Make A39 active.

• Click Thesaurus in Review tab.

• Point to transport in word list,

click down-pointing arrow, then

click Insert.

• Click Research in Proofing

group to turn off Research

task pane.

• Save workbook as

ExcelS2-01.xlsx.

ACTIVITY

2.1

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Inserting and Deleting Columns and Rows

• With ExcelS2-01.xlsx open, position cell pointer 

over row indicator 24, hold down left mouse button, 

then drag mouse down over 25.

• Click Home tab, click Insert arrow, then click Insert

Sheet Rows.

ACTIVITY

2.2

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Inserting and Deleting Columns and Rows

• Click A24, type Vegetable tray with dip, then press 

Enter.

• Type Seafood hors d'oeuvres then press Enter.

ACTIVITY

2.2
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Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Inserting and Deleting Columns and Rows

• Select row 32.

• Click Delete arrow then click Delete Sheet Rows.

ACTIVITY

2.2

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Inserting and Deleting Columns and Rows

• Select row 22. Hold down Ctrl key then select rows 

30 and 35.

• Position pointer within any three selected rows, 

right-click to display shortcut menu and Mini toolbar, 

then click Delete.

ACTIVITY

2.2

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Inserting and Deleting Columns and Rows

• Select column F then display shortcut menu and 

Mini toolbar by positioning cell pointer over column 

indicator letter F and right-clicking mouse.

• At shortcut menu, click Delete.

ACTIVITY

2.2

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Inserting and Deleting Columns and Rows

• Click any cell to deselect column.

• Make F11 active, type November 5, 2009, then 

press Enter.

• Save ExcelS2-01.xlsx.

ACTIVITY

2.2

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Moving and Copying Cells

• With ExcelS2-01.xlsx open, make E5 active.

• Click Cut      in

Clipboard group in

Home tab.

• Make A9 active

then click Paste

in Clipboard group. 

ACTIVITY

2.3

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Moving and Copying Cells

• Select range A17:B18.

• Point at any of four

borders surrounding

selected range.

• Hold down left mouse

button, drag top left

corner of range to

E15, then release

mouse.

ACTIVITY

2.3
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Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Moving and Copying Cells

• Make D28 active.

• Click Copy       in Clipboard

group.

• Make D32 active,

click Paste arrow in

Clipboard group, then click

Paste Link.

• Press Esc to remove moving

marquee from D28.

ACTIVITY

2.3

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Moving and Copying Cells

• Make D28 active, edit

value to 4.09.

• Make A23 active. Point at any of four borders 

surrounding A23 until pointer displays as white 

arrow with move icon

attached, hold down Ctrl key,

then drag mouse to A36.

• Release mouse button first then

release Ctrl key.

• Save ExcelS2-01.xlsx.

ACTIVITY

2.3

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Creating Formulas with Absolute Addressing

• With ExcelS2-01.xlsx open, make K20 active then 

type Food.

• Make L20 active then type Prep.

• Make M20 active then type Server.

• Type decimal values in K19, L19, and M19 as 

shown.

ACTIVITY

2.4

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Creating Formulas with Absolute Addressing

• Make K21 active, type =(c21*e21*h21)*k19, then 

press F4.

• Press Enter.

• Make L21 active, type formula 

=(c21*e21*h21)*$I$19, then

press Enter.

• Make M21 active then type formula 

=(c21*e21*h21)*$m$19 by

typing dollar symbols or by

pressing F4.

ACTIVITY

2.4

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Creating Formulas with Absolute Addressing

• Select range K21:M21 then click Copy in Home tab.

• Select range K28:M28, hold down

Ctrl key, then select range K32:M32.

• Click Paste in Clipboard group.

• Press Esc to remove

moving marquee from

selected range.

ACTIVITY

2.4

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Creating Formulas with Absolute Addressing

• Click K28 then look at Formula bar to see formula 

that was pasted into cell: =(C28*E28*H28)*$K$19.

• Click L32 then look at Formula bar

to see formula that was pasted

into cell. 

• Enter Sum function to calculate

totals in K39, L39, and M39.

• Save ExcelS2-01.xlsx.

ACTIVITY

2.4
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Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Adjusting Column Width and Row Height

• With ExcelS2-01.xlsx open, make any cell in 

column C active.

• Click Format in Home tab

then click Column Width.

• At Column Width box, type 14

then click OK or press Enter.

ACTIVITY

2.5

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

• Position mouse pointer on boundary line in column 

indicator row between columns D and E until 

pointer changes to a vertical line with left- and right-

pointing arrow.

• Hold down left mouse button, drag boundary line to 

right until Width: 15.00 (110 pixels) displays in 

ScreenTip, then release mouse button.

Adjusting Column Width and Row Height
ACTIVITY

2.5

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Adjusting Column Width and Row Height

• Position mouse pointer on boundary line in column 

indicator row between columns E and F until pointer 

changes and double click left mouse button to 

Autofit width.

• Increase width of column B to 12 (89 pixels) using 

Column Width box or by dragging the column 

boundary.

ACTIVITY

2.5

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

• Position mouse pointer on column indicator letter C, 

hold down left mouse button, then drag mouse right 

to column M.

• Position mouse pointer on any of right boundary 

lines to right of column E within selected range of 

columns until pointer changes.

• Drag boundary line right until

Width: 15.00 (110 pixels) displays

in ScreenTip then release

mouse button.

Adjusting Column Width and Row Height
ACTIVITY

2.5

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Adjusting Column Width and Row Height

• Click any cell to deselect columns.

• Move E15:F16 to A17:B18 then click any cell to 

deselect range.

ACTIVITY

2.5

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

• Position mouse pointer on boundary line below row 

20 until pointer changes to horizontal line with

up- and down-pointing

arrow.

• Drag boundary line down until Height: 19.50

(26 pixels) displays in ScreenTip then release 

mouse button.

• Save ExcelS2-01.xlsx.

Adjusting Column Width and Row Height
ACTIVITY

2.5
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© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Changing the Font, Size, Style,

and Color of Cells

• With ExcelS2-01.xlsx

open, make A9 active.

• Click Font arrow in

Home tab, scroll down

list of fonts to Impact.

Click Impact at

drop-down gallery.

ACTIVITY

2.6

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Changing the Font, Size, Style,

and Color of Cells

• Click Font Size arrow in Font group then click 18.

• With A9 still active, click Font Color arrow then click 

Blue color box in Standard Colors section.

ACTIVITY

2.6

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Changing the Font, Size, Style,

and Color of Cells

• Select A9:F9 then click Merge & Center in 

Alignment group.

• With merged cell A9 still selected, click Fill Color 

arrow in Font group then click Accent 5, Lighter 

80% color box in Theme Colors section.

ACTIVITY

2.6

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Changing the Font, Size, Style,

and Color of Cells

• Make A39 active.

• Hold down Ctrl key then click F39.

• Click Bold and Italic in Font group.

• Click any cell to deselect A39 and F39.

• Save ExcelS2-01.xlsx.

ACTIVITY

2.6

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Formatting Numeric Cells; Adjusting 

Decimal Places; Using Undo and Redo

• With ExcelS2-01.xlsx open, make F21 active.

• Hold down Ctrl, click I21, K21:M21, F39, I39, and 

K39:M39.

• Click Accounting

Number Format

in Home tab.

ACTIVITY

2.7

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

• Click any cell to deselect the cells.

• Select F28:F37, I28:I37, and K28:M32.

• Click Comma Style in Number group.

Formatting Numeric Cells; Adjusting 

Decimal Places; Using Undo and Redo

ACTIVITY

2.7
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© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Formatting Numeric Cells; Adjusting 

Decimal Places; Using Undo and Redo

• Click any cell to deselect cells and review numeric 

values in worksheet. 

• Select J21:J39.

• Click Percent Style       in Number group.

• With range J21:J39 still selected, click

Increase Decimal       twice.

• With range J21:J39 still selected, click

Decrease Decimal       once.

• Click any cell to deselect range.

ACTIVITY

2.7

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Formatting Numeric Cells; Adjusting 

Decimal Places; Using Undo and Redo

• Select D37 and H37 then click Increase Decimal 

twice to display two decimal places.

• Deselect cells.

• Click Undo       two times.

• Click Redo      two times.

• Save ExcelS2-01.xlsx.

ACTIVITY

2.7

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Changing the Alignment and Indentation

of Cells; Using Repeat

• With ExcelS2-01.xlsx open, edit column headings 

C20 and E20 to include a period after the 

abbreviation for number. 

• Select C20:M20.

• Click Center       in

Home tab.

• Select C21, C28, and

C32 then change

alignment to center.

• Center entries in

column E.

ACTIVITY

2.8

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Changing the Alignment and Indentation

of Cells; Using Repeat

• Select A22:A27.

• Click Increase Indent       in

Alignment group.

• Select A29:A31 then click

Increase Indent.

• Select A33:A36 then click

Increase Indent.

ACTIVITY

2.8

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Changing the Alignment and Indentation

of Cells; Using Repeat

• Select A20:M20 then bold the cells.

• Make F11 active  then

click Align Text Left in

Alignment group.

• Select A20:M20.

• Click Middle Align in

Alignment group and

deselect range.

ACTIVITY

2.8

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Changing the Alignment and Indentation

of Cells; Using Repeat

• Select E1:F1 then click Merge & Center.

• Select E2:F2 then press Ctrl + Y.

• Select E3:F3 press Ctrl + Y.

• Select E1:E3 then click Align Text Right.

• Deselect range.

• Save ExcelS2-01.xlsx.

ACTIVITY

2.8
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© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Adding Borders and Shading; Copying Formats 

with Format Painter; Using Cell Styles

• With ExcelS2-01.xlsx open, change width of 

column A to 11.00 (82 pixels). 

• AutoFit columns C–F, and H–M.

• Change width of column G to 4.00 (33 pixels).

ACTIVITY

2.9

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Adding Borders and Shading; Copying Formats 

with Format Painter; Using Cell Styles

• Select A20:M20.

• Click Bottom Border arrow

in Font group in Home tab.

• Click Top and Bottom

Border at drop-down list.

• Click any cell to deselect

range and view border.

ACTIVITY

2.9

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

• Select A21:B21, click Top and Bottom Border 

arrow, then click Outside Borders.

• Select A28:B28 then click

Outside Borders button.

(Do not click arrow.)

• Select A32:B32 then click

Outside Borders.

• Deselect range.

Adding Borders and Shading; Copying Formats 

with Format Painter; Using Cell Styles

ACTIVITY

2.9

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Adding Borders and Shading; Copying Formats 

with Format Painter; Using Cell Styles

• Make F39 active, click Outside Borders arrow, then 

click Top and Double Bottom Border.

• With F39 still active, double-click Format Painter       

in Clipboard group.

• Click I39 then drag cell pointer to select K39:M39. 

Click Format Painter to turn off feature.

ACTIVITY

2.9

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Adding Borders and Shading; Copying Formats 

with Format Painter; Using Cell Styles

• Select E1:F8.

• Click Fill Color arrow in Font group then click white 

color box (Background 1).

• Deselect range.

ACTIVITY

2.9

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Adding Borders and Shading; Copying Formats 

with Format Painter; Using Cell Styles

• Select A9.

• Click Cell Styles in Home tab.

• Move mouse over several cell style designs and 

watch Live Preview show style applied.

• Click Title style in Titles and Headings.

ACTIVITY

2.9
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© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Adding Borders and Shading; Copying Formats 

with Format Painter; Using Cell Styles

• Select A20:M20, click Cell Styles in Styles group, 

then click Accent2 style in Themed Cell Styles.

• Select A21:B21, A28:B28, and A32:B32 and apply 

Accent1 style in Themed Cell Styles.

• Select K19:M19,

apply Note style in

Data and Model

section.

ACTIVITY

2.9

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Adding Borders and Shading; Copying Formats 

with Format Painter; Using Cell Styles

• Select A1:F42.

• Click Office then click Print.

• At Print box, click Selection

in Print what section then

click OK.

• Deselect range.

• Click Page Layout tab.

• Click Orientation in

Page Layout tab then

click Landscape.

ACTIVITY

2.9

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Adding Borders and Shading; Copying Formats 

with Format Painter; Using Cell Styles

• Click Width arrow in Scale to Fit group then click

1 page.

• Click Height button arrow in Scale to Fit group then 

click 1 page.

• Click Quick Print button and save ExcelS2-01.xlsx.

ACTIVITY

2.9

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Using Find and Replace

• With ExcelS2-01.xlsx open, press Ctrl + Home to 

make A1 active.

• Click Home tab.

• Click Find & Select in Editing

group then click Find.

ACTIVITY

2.10

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Using Find and Replace

• Type *tray* in Find what box then click Find Next.

• Click Find Next four times.

• Click Close to close Find and Replace box.

ACTIVITY

2.10

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

• Click Find & Select in

Editing group then

click Replace.

• Drag to select *tray*

in the Find what text

box then type 40.

• Press Tab to move insertion point to Replace with

box then type 43.

• Click Replace All, then click OK at message that 

Excel has completed search and made four 

replacements.

• Click Close button to close Find and Replace box.

Using Find and Replace
ACTIVITY

2.10

40

43
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Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Using Find and Replace

• Review No. of Days column in worksheet and note 

that four replacements were made in E21, E28, 

E32, and E37.

• Save ExcelS2-01.xlsx.

ACTIVITY

2.10

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Freezing Panes; Changing the Zoom

• With ExcelS2-01.xlsx open, make C10 active.

• Click View tab.

• Click Freeze Panes in Window group.

• Click Freeze Panes at drop-down list.

ACTIVITY

2.11

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

• Press Page Down to scroll down worksheet.

• Press Ctrl + Home. Note Excel returns to C10 

instead of A1 since A1 is frozen.

• Scroll several screens to the right.

• Press Ctrl + Home.

• Scroll right until column

H is immediately right

of column B then scroll

down until row 20 is

immediately below

row 9.

Freezing Panes; Changing the Zoom
ACTIVITY

2.11

Lines indicate which rows
and columns are frozen.�

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

Freezing Panes; Changing the Zoom

• Click Freeze Panes then click Unfreeze Panes.

• Practice dragging Zoom

slider at right end of Status

bar and watch cells magnify

and shrink as you drag right

and left.

• Drag slider to halfway mark on slider bar to 

redisplay worksheet at 100%.

ACTIVITY

2.11

© Paradigm Publishing Inc.

Links to 

Activities

2.1

2.2

2.3

2.4

2.5

2.6

2.7

2.8

2.9

2.10

2.11

• Click over 100% at left edge of slider bar to open 

Zoom box.

• Click 75% then click OK.

• Click Zoom In at right end of

Zoom Slider bar.

• Click Zoom In

until zoom percentage returns

to 100%.

• Save and close ExcelS2-01.xlsx.

Freezing Panes; Changing the Zoom
ACTIVITY

2.11


